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Easy-to-use tool, lets you generate
custom GUIs with minimum
programming

Use your generated GUI to:

- Automate testing

Generate reports

Consistently test across your organization

- Control switch matrix for automated multi-lane
interface testing

Add analysis to your compliance and debug software
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Easy documentation of all tests in HTML, pdf, or csv formats.

Custom Automation for Your Keysight
Oscilloscope

Create the Applications that you need

Automated testing continues to be an extremely important
part of today’s engineering environment. Today’s oscilloscope
vendors provide compliance applications such as USB 3.0,
PCle, MIPI and DDR to provide specific automation for the
technology that you need to ensure certification of your
design.

However, compliance applications are created specifically to
the technology that you purchase. These applications lacked
the ability to be modified, which meant limited flexibility
until the addition of UDA. Any custom automation had to

be done on your own with more complicated programming
environments.

Keysight oscilloscopes now solve this problem with the User
Defined Application (UDA). UDA is the only fully customizable
automated environment made for an oscilloscope by an
oscilloscope designer. It provides full automation, including
the ability to control other Keysight Technologies, Inc.
instruments, external applications such as MATLAB, and your
DUT software. UDA also provides the ability to add custom
tests to your Infiniilum compliance applications. In addition,
UDA automates and customizes your multi-lane interface
testing with available switch matrix (Keysight U3020AS26
and BitifEye BIT-2100 Series) or custom switch matrix. UDA
switches the signal under test from a multi-lane interface
automatically so you do not have to be in front of the test
setup to do this manually. It also supports test plan feature,
which iteratively runs through the different permutations of
your device setup and tracks the results. It makes testing of
multi-lane signals more efficient and saves you time.

When working with InfiniiVision oscilloscopes, the UDA
application executes on a Windows PC and uses a network
or USB connection to fully control and automate the test
process. For Infiniium oscilloscopes, it is optional to run on
a separate PC or directly on the oscilloscope, giving you the
flexibility to optimize your test environment.
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User Defined Application (UDA)

UDA's environment: developed for
oscilloscope test

There are two key differentiators for UDA from programs
such as Keysight's VEE. The first is that UDA was

designed specifically for Keysight oscilloscopes. The UDA
development environment is easier to use than other test
and measurement automation packages, which allows you
to spend less time programming and more time testing
your application. The second key differentiator is that

the environment built around the Infiniium proprietary
compliance testing framework, which gives you features
developed for Infiniium’s compliance testing and the
customization you wanted. Other oscilloscope vendors may
have compliance applications or leverage development
environments such as VEE; however, only Keysight
oscilloscopes have the added advantage of the flexibility and
ease of use of UDA.

UDA’s development environment

Similar to other programming applications; UDA has its
own development environment. The environment can be
downloaded for free at www.keysight.com/find/uda.

The UDA environment includes all the tabs that you would
see in a typical compliance application, however, you control
the tests and automation that you need.

To make developing simple and easy, the development
environment has two modes (Basic and Advanced). Basic
mode allows you to quickly build an application. Tests written
for basic mode will load a single setup file and execute a
single script or command. You get variable set up, and can
load your own company logo.

All the features that are included in basic mode are also
included in advanced mode. In addition, advanced mode
adds connection diagrams, external instrument control,
external application value source (file based), test grouping,
sequential test steps, and independent scripts running during
testing.

File Edit Build

DEH=EmE

Tools Help

Application

Name:

Version:  0.01.0001 |

InfiniiVision

Minimum Version:  vel

J S TR A e

Set Up | Tests | Configs | Connections | Subroutines [ Events | Miscellaneous | Debug Run | Build | Automation |

Set
([ seect Project ) ]

@ Start New Project
[ Platfor | Product | Summary |
© fdch j
@ Infinium

Fitsrs
[ Include test group fi
| Include option

BExdemal Instruments

@ InfiniiVision

() Open Bxisting Project

(@) Open Restore Point

Neat >

Cancel

Actions

[7] Enable cortrol

Manage Nickname ~ Socket Description

Build Summary-

* Drag barto resize ™

Build | Find

Ready InfiniiVision Application

Figure 1. Keysight’s User Defined Application supports multiple oscilloscope

types.
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Figure 2. Basic UDA development environment
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Infiniium User Defined Application (UDA)

Integrate other Infiniium analysis software into
your UDA

UDA is fully compatible with all the Infiniium oscilloscope
applications via SCPI commands. This compatibility includes
Infiniilum applications such as Serial Data Equalization,
Serial Data Analysis, EZJIT Plus, InfiniiSim and InfiniiScan.
By combining UDA with these Infiniium applications, you are
able to get exactly the automated analysis that you need. For
example, you can create a UDA to find which equalization
algorithm will open your eye the best. Simply combine

UDA with the Serial Data Equalization and the eye height
measurement and you can quickly find the filter you need for
the optimal filter design. Not only will you know which tap
values to use, but you will also have your customized HTML
report to show it.

In addition to working with all other Infiniium software, UDA
is fully compatible with MATLAB and Infiniium’s User-Defined
Function, which allows you unprecedented flexibility in your
measurement capability and in your automation software.
UDA even allows you to import MATLAB graphics into your
user-defined application report.

Use your add-in capability to create tests that unlock the
power of de-embedding and your application. Compliance
applications may allow you to de-embed a fixture, but UDA
allows you to show the improvement in your design by
removing the cable and the fixture.
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Figure 3. Simple process to create multiple test sequences with individual
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Figure 4. After the UDA has run, you get your own customized HTML report.
You can import any image onto the report, allowing for customization of the
application that you are running.
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Figure 6. Manually enter a sleep command. Notice how the GUI allows for
easy execution.
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Figure 7. Easily add any setup files to your UDA to guarantee testing
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Figure 9. Add scope screen shot after the test executes. This will be added to
your HTML report
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User-defined application provides features with
ease of use in mind

Once you have created a test, you can copy it, delete it, move
it to a group or edit it. The same is true about a group of
tests, you can easily copy a group of tests and create a new
group of tests and then edit each individual test. Because
UDA allows you to do this, you don’t need to type the same
test multiple times. This saves you time and helps to eliminate
errors.

Add your own external applications

One of the most advanced features of UDA is the ability to
run any external application to your UDA. You can create
a script from VBA or C# and then execute it into the UDA
application. This allows you to add customizable consoles.

Figure 11 shows a UDA that was created for setting up
testing of SDI (serial data interface). The VBA example occurs
at run time and allows the user to test to the exact conditions
the user wishes for testing.
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Figure 10. Create, copy, edit your tests and groups of tests
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Figure 11. Easily debug as you create custom applications



07 | Keysight | N5467B and N5467C For Infiniium and InfiniiVision Oscilloscopes User Defined Application (UDA) Data - Sheet

Complete variable control

UDA also allows you to set up and use variables. This
simplifies your programs. For instance if you are using CHAN
as the variable for my oscilloscopes’ four channels, you can
set channel 1 as the default. Create variables that are input
by the user at run-time on the scope.

Building your program

Once you have completed your UDA you can “generate” the
application that you have developed. There are four different
options for building your applications that include the
following:

- Build application

- Launch application (Works when you are developing
the UDA on your oscilloscope. This will launch the
application on the oscilloscope).

- Generate installer (Generates the application and
generates a zipfile to be downloaded and installed on
your oscilloscopes desktop).

- Install application (Works when you are developing the
UDA on your oscilloscope. This will install everything
you need to run the UDA. When you use this option,
the application is permanently installed on your
oscilloscope).

At any time during the development of your application you
can do a “debug” run, which allows you to check for any
errors, such as a file not existing or a path being incorrect.
Debug runs also can check to see if any external instruments
you are controlling can be found.

Config Definition

Corfig
Displayed Nams:  Acquistion Points
Varizble Name:  veAcquisitionPoints

Description: .Aéql:l.i.smc.m F'olrrtsﬁnthe menu unéer‘é;etun—#‘;ﬁcquism.on.]

Choices

Cptions
DebugRun Value: 200000 (Menu: Tools > DebugRun)

[ During & run, prompt to change connection when this corfig changes

Allow userto add new choices [ Min (nclusive):
[ Max gnclusive): |
[] Show onty when Generated Application is in Debug Mode

[ Find References... ] [ Change References...

File Edit Build Tools Help
NDEH FEPa

T Qe e
Set Up | Tests | Corfigs [ Connections | Subroutines | Evens | M

Build Launch
Copies user files to intemal cache and builds. Build and run the application now.

ss | Debug Run | Buid | Automation

Build Application Launch Application

Allow installation an PC

Install Generate Installer

Builds the application and installs on this Buiild the application and generate an installer.
machine now. Use Infiniium's Analyze > (Copy file to scope and execute it )

Automated Test Apps menu to launch application.

install Applcation l [ Generate Installer

File saved to

“ Drag bar to resize ~

Build Summary:

Buid | Find

Ready Infiniium Application

Figure 13. Four different options to build your program
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After the application is installed

Once you have developed your UDA and installed it on your
oscilloscope. The application is fully integrated into the
Infiniilum GUI. You run your UDA like any of Infiniium’s best-in-
class compliance applications. The application can be found
in the Analyze menu under the automated test apps.

[E1C) 130.29.70.185
27 May 2009 10:02 |
Math (FFT and more)...
Histogram....
Mask Test...

Jitter Setup...

Serial Data...

Equalization...

Automated Test Apps 0 DDR2 Test
Vector Signal Analysis... SATAGG Test

User-Defined » MkauSlom Automation Tool

Figure 14. Full Integration of UDA in Infiniium baseline software

Combining UDA add-in capability with your
Infinilum compliance applications

Available in UDA version 2.50 and later, you can now create
test add-ins. A test add-in can be added to your Infiniium
compliance application, such as SAS-3 or PCle Gen3. This
capability now allows you to test to the exact compliance
specification and then create additional customized
automation tests through UDA and test them all in the same
report. This now gives you the unmatched combination of
the ease of use of compliance applications and the flexibility
customized technologies. There is no other tool in the
oscilloscope industry that allows this combination.

Using add-in capability

User defined application can be combined with any Infiniium
compliance application, making it possible to get the
ease-of-use of Keysight’s compliance applications with the
flexibility of UDA.

UDA add-in capability adds a completely unique experience
when using Keysight's software. Create a test you need in
UDA, then add it to your compliance application.
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Figure 15. The appearance of the application software is very close to
Infiniium’s industry leading compliance applications.
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Figure 16. Test results are can easily be reviewed, re-run, or executed multiple
times before creating a test report
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Switch matrix

The custom switch matrix software option for UDA used
together with switch matrix hardware provides automated
and customizable testing for multi-lane digital bus interfaces.
The benefits of the automated switching solution include:

- Eliminate reconnections—which saves time and reduces
errors through automating test for each lane of a
multi-lane bus.

- Maintain accuracy—with the use of unique PrecisionProbe
or InfiniiSim to compensate switch path losses and skew.

- Customize testing—with the use of remote programming
interface and UDA for device control, instrument control
and test customization.

More information of the switching solution and configuration,
visit www.keysight.com/find/switching and Using
Microwave Switches When Testing High Speed Digital
Interfaces application note (Keysight publication number
5991-2375EN).
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Figure 18. Automated testing for multi-lane digital bus interface through

switching solution.
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Share, modify and transfer user-defined
applications and add-ins

UDA development environment is free to download at
www.keysight.com/find/uda. You can create your UDA and
shares your application both on site or trans-regionally. You
can run as many UDAs on your oscilloscope as you would like
with one license.

You can find examples of UDA at:
www.keysight.com/find/share_uda

You can also share the UDAs that you have developed. You
can download an example and then modify the application to
be the exact application that you need with one license.

B T 0

) Dt ——
\Il’ ey Wiow Chwrmacki = Tum dosp 11, 1000 584w Tww desf 13, 3308 B odd o

0 ot the W00 S o 4 B

b basany + T Jun B8, 5069 13:36 pm Tha Jan 04, 200 11/28 oy
() Lk s amahie B e OO S 9 Hscnpn B )
W) by btaay o S B 34, 5508 1542 am 9 o T D L. 1008 1247 am

(3) Coteg Lon maduis b Pt

2 sar by
ey maigsnbel = M Dot 08, 2008 198 e

W D 04, B0 436 pom

() LRl LMK S s e NN S < e MbesierC
A Wby baanay = ot Mow 00, 2008 5K pew Bt ey 41, 008 N AT e
B by anc I b baminr
@nm-u--n,msn—w 9 T e 31, 3900 BT e
() ATRAB devet o Vin OO St g b
W By hasmay » Sat o 2, 2008 5.1 pew e o8 W G, 2908 §:07 o
B Wit cam | o V0 008 s, b e NN St o arr B bemar
Lhm'mmm,:nlmn Mo Ot . D0 %89 e
(@) Jowe Amakgres B8 Dacades ” by bassar
) iy bamser » ok on 13, 3508 4k o a T8 e fon 13, 00 406 g
() Comtentng v st ¥ Myt e iy Bbeser
W) Wby by o T g 20, 2008 900 4 Tha dug 2, 2008 001 am
(5) 1 e e e T
W) 8y bamer o T g 20, 2008 .08 am T g 1, 2508 % 81 arm
) Wemsam e KSR comrmrim s1a  bemerid
iy basany + e b L3, 1000 0 pm e a e g 1, 7008 3163 p
() Derad Lutgs Wammbrm T osen yoem Scoge bo P e baasay
L) 0y basaiy + wd g L3, 5088 %30 o (] W50 g 41, 100N %8 e
=

Figure 19. Share your applications at www.keysight.com/find/share_uda
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Figure 20. SDI application that is available for your download today
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Oscilloscope Compatibility

InfiniiVision Oscilloscopes Software Version Supported
3000T series 7.0 or greater
4000A series 710 or greater
6000A series 7.0 or greater
Infiniium Oscilloscopes

S-series all

V-series all

Z-series all

9000A series all

9000H series all

90000A series 1.47 or greater
90000 Q series all

8000A series 5.5 or greater
800008 series 5.5 or greater
90008A series digitizers all

Ordering Information

N5467B - UDA Fixed perpertual Transportable Server-based
InfiniiVision N5467B-4FP N5467B-4TP -

Infiniium N5467B-1FP N5467B-1TP N5435A-058
Switch Matrix N5467B-7FP N5467B-7TP N5435A-708

SR

N5467B and N5467C are equivalent products and utilize the same license options.
Infiniium license (1FP and 1TP ) includes support for InfiniiVision oscilloscopes.
Software system requirements:
- Software 4.30 or above requires Windows 7.
- NET 4.5.2 https://www.microsoft.com/en-us/download/details.aspx?id=42643
- Keysight O Libs version18.0 or greater http://www.keysight.com/find/iosuite
- Keysight License Manger version 5.1 or greater http://www.keysight.com/find/licensing
Infiniilum oscilloscope requirements:
- N2753A Infiniium Windows XP to 7 OS upgrade kit (oscilloscope already has M890 motherboard)
- N2754A Infiniium Windows XP to 7 OS and M890 motherboard upgrade kit (oscilloscope without M890 motherboard)
- Verify the M890 motherboard using the procedure found in the Windows 7 upgrade kit data sheet, publication number 5990-8569EN
UDA software license is required to run generated UDA program on the oscilloscope.
UDA software license is a pre-requisite to use custom switch matrix.
For full switch configuration, please refer to www.keysight.com/find/switching or the Automated Switching Solution for Oscilloscopes brochure,
publication number 5991-2413EN.
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Keysight Oscilloscopes

Multiple form factors from 20 MHz to > 90 GHz | Industry leading specs | Powerful applications
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